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And you were dreaming of palm trees
and sunshine...

8 a.m., a miserable, stormy morning. After an hour-long commute in the
pouring rain, you slosh into the Acme Detective Agency, grunt hello to
your secretary, pour yourself a cup of scalding coffee and slump at your
desk. It’s been a tough year. The only thing good about it is that you've
earned a vacation and you're scheduled to leave at 5 p.m. today. You take a
swig of coffee and grab a travel brochure from your desk. Visions of sandy
beaches, swaying palms, and cool blue waters fill your head.

Suddenly, you’re snapped back to reality by a newspaper slammed down on
your desk. “Read it and weep,” a voice growls. Matt Brannigan, a beefy-
faced lunk and one of the agency’s top men, is looking down at you with a
twisted grin.

You scan the headlines and your heart skips a beat. You can’t believe your
eyes: Carmen Sandiego has escaped from the toughest prison in Europe!

“The Chief has cancelled all vacations and put everyone on 24-hour-a-day
alert,” your colleague says. “We've got it on good authority that Carmen’s
headed for the U.S.A. with the worst gang of thugs and criminals ever
assembled. No one rests until she’s behind bars agam"’

As you slam dunk your now worthless travel brochure into the metal trash
basket beside your desk, you can’t help but wonder at Carmen’s timing in
re-establishing her Villain’s International League of Evil (V.LL.E.) in the
U.S.A. Why couldn’t she have waited? Just a few hours more and it
wouldn’t have been your problem. Grimly, you gather your trench coat
around you and head for the door.




“Maybe you’ll get to see a bit of the country during this caper,” your fellow
detective offers as you head for the door. “Yeah,” he chuckles, “just think
of the whole thing as one big vacation—it’ll make it easier.”

READY FOR DUTY
Getting Started

We encourage you to make one backup copy of each disk. Store the original
disks in a safe place and use the backups to play the game.

Macintosh

For two disk drives:

Turn on your computer. Insert both disks of WHERE IN THE U.S.A. IS
CARMEN SANDIEGO? into their respective disk drives. Double-click the
Carmen USA icon when it appears on the screen. The program will load
itself into your computer and an animated title sequence will appear. Click
the mouse button to stop the animation and begin the game.

For one disk drive:

Turn on your computer. Insert Disk 1 of WHERE IN THE U.S.A. IS
CARMEN SANDIEGO? into your disk drive. Double-click the Carmen
USA icon when it appears on the screen. After the program loads into
memory, the disk will automatically be ejected from the disk drive. When
prompted to insert Disk 2, insert WHERE IN THE U.S.A. IS CARMEN
SANDIEGO? Disk 2 into the disk drive. At this time you will be prompted
to swap disks; follow the instructions on the screen. The program will load
itself into your computer and an animated title sequence will appear. Click
the mouse button to stop the animation and begin the game.

Apple IIcs

For two disk drives:

Insert both disks of WHERE IN THE U.S.A. IS CARMEN

SANDIEGO? into their respective disk drives. Turn on your computer.
Double-click the Carmen.USA program icon when it appears on the
screen. The program will load itself into your computer and an animated
title sequence will appear. Click the mouse button to stop the animation
and begin the game.

For one disk drive:

Insert Disk 1 of WHERE IN THE U.S.A IS CARMEN SANDIEGO? into
your disk drive. Turn on your computer. Double-click the Carmen.USA
program icon when it appears on the screen. At this time you will be
prompted to swap disks; follow the instructions on the screen. After the
program has loaded itself into the computer, an animated title sequence
will appear. Click the mouse button to stop the animation and begin the
game.

Note: The program requires ROM version 1.0 or higher.

Amiga

For two disk drives:

Turn on your computer. Amiga 1000 users will have to insert the
Kickstart™ disk before continuing. When the Workbench™ disk is
requested, insert the WHERE IN THE U.S.A. IS CARMEN SANDIEGO?
Disk 1 into the internal drive and insert Disk 2 into your external disk
drive. Double-click the disk icon named Carmen USA and then double-
click the Carmen USA program icon when it appears on the screen. The
program will load itself into your computer and an animated title sequence
will appear. Click the mouse button to stop the animation and begin the
game.




For one disk drive:

Turn on your computer. Amiga 1000 users will have to insert the
Kickstart disk before continuing. When the Workbench disk is re-
quested, insert Disk 1 of WHERE IN THE U.S.A. IS CARMEN SANDI-
EGO? into your disk drive. Double-click the disk icon named Carmen
USA and then double-click the Carmen USA program icon when it
appears on the screen. At this time you will be prompted to swap disks;
follow the instructions on the screen. The program will load itself into your
computer and an animated title sequence will appear. Click the mouse
button to stop the animation and begin the game.

Macintosh, Apple IIs and Amiga

To be promoted to the next detective level, you will need to answer a
question using Fodor’s® USA travel guide included in the package (See
page 11).

Installing the Program on a Hard Disk

Macintosh

Turn on your computer and, if necessary, your hard disk. Click the icon
for your hard disk to open the hard disk window. Create a new folder by
choosing New Folder from the File menu. Rename the folder Carmen
USA. Insert the Carmen USA Disk 1 into your Macintosh. Drag the
Carmen USA icon and the folder named Carmen USA Music from the
Carmen USA Disk 1 window over to the folder named Carmen USA on
the hard disk. A dialog box will appear showing the progress of the copy
process. When it is complete, eject the Carmen USA Disk 1 by dragging
its icon over the Trash icon.

Now insert the Carmen USA Disk 2 into the Macintosh. Drag the folder
named Carmen USA Graphics from Carmen USA Disk 2 over to the
folder named Carmen USA on the hard disk. A dialog box will appear

showing the progress of the copy process. When it is complete, eject the
Carmen USA Disk 2 by dragging its icon over the Trash icon.

Apple IIcs

Turn on your computer and hard disk. Double-click the icon for your hard
disk to open the hard disk window. Create a new folder by choosing New
Folder from the File menu. Rename the folder Carmen.USA by choosing
Rename from the File menu. Insert WHERE IN THE U.S.A. IS CARMEN
SANDIEGO? Disk 1 into your internal disk drive. When the disk window
appears on the desktop, single-click the Carmen.USA program icon then
hold down the shift key and single-click the Carmen.USADatal folder.
Drag the two icons across the desktop until they cover the Carmen.USA
folder icon on your hard disk drive. The program and folder will be copied
onto your hard disk.

When the copy is complete, eject Disk 1 by pressing the button on the disk
drive. Insert Disk 2 and drag the Carmen.USAData2 folder across the
desktop until it covers the Carmen.USA folder icon on your hard disk
drive. The folder will be copied onto your hard disk. Open the folder on
Disk 2 named Icons. Drag the icon across the desktop to the folder
named Icons that is on your hard drive. Copying the icon for WHERE IN
THE U.S.A. IS CARMEN SANDIEGO? to your hard drive will allow the
Apple IIGS to show the Carmen.USA icon instead of the generic applica-
tion icon that you normally see.

Amiga

Turn on your computer and hard disk. For those hard drives that are not
auto-booting, use your own Workbench boot disk when starting your
machine. Double-click the icon for your hard drive to open the hard disk
window. Create a new drawer by single-clicking on the Empty drawer icon
on your hard disk and then choosing Duplicate from the Workbench
menu. Rename the new drawer, which will now be named Copy of
Empty, by single-clicking it and selecting Rename from the Workbench
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menu. Rename the drawer Carmen USA. Insert Carmen USA Disk 1 into
your floppy disk drive. Double-click the Carmen USA Disk 1 icon. Drag
the drawer icon named Carmen USA Data 1 and the program icon
named Carmen USA from the floppy disk to the new drawer on your hard
drive. When the copy is complete, eject Disk 1 by pressing the button on
the disk drive. Insert Carmen USA Disk 2 and drag the drawer icon
named Carmen USA Data 2 from this floppy disk to the new drawer on
your hard drive.

Double-click the Font Mover 1.1 icon. Click the gadget (DF0: or DF1:)
where the Carmen USA program disk is located. This will display the
three fonts to be copied. Click the gadget for the destination to which the
Font Mover should copy all of the fonts on the Carmen USA program
disk. You should select the font directory on your hard drive or the font di-
rectory on the Workbench floppy disk that you usually start up your
Amiga with. Hold down the left mouse button and drag the cursor across
the fonts that you want to copy to the destination directory. You should
select all three fonts on the Carmen USA disk. The fonts highlighted will
be copied to the destination directory.

Click the Copy gadget to initiate the copy procedure. After the Font Mover
has finished the copy, click the Close gadget in the upper left hand corner
of the Font Mover window.

Using Expanded Memory

Amiga

If you have one megabyte or more of memory you can run WHERE IN
THE U.S.A. IS CARMEN SANDIEGO? faster by telling the program to use
more memory. The program will use about 512K additional memory. To
run the program using additional memory you will need to change the N to
a'Y in the tool types of the Carmen USA program icon.

Single-click the Carmen USA program icon. The icon should now be
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highlighted. Go to the menu bar and place the pointer over the word
Workbench. Press the right mouse button and select Info from the pull-
down menu.

The Info window will appear with Carmen USA in the Name box. Toward
the bottom of the Info window, a box will say:

TOOLTYPE BIGMEM-=N

Change the N to a Y for YES. Click the Save gadget at the bottom of the
Info window. The change will be saved and the Info window will close.

The program will now run with additional data in memory.

Should there be too little memory for the program to run with
BIGMEM-=Y, an alert will appear when you try to run the program. If you
see the message, “Not enough Memory!” go back into the Info window and
set BIGMEM-=N.

One Last Note: Carmen USA is designed to run from your Workbench.
There are two keyboard commands that you might find valuable. The “A”
shown below refers to the Amiga key to the left of the spacebar. By holding
down the Amiga key and pressing the “n” or “m” you will achieve the
following results:

A + n: bring the Workbench forward

A + m: send the Workbench to the back

Using the Program

Macintosh and Apple IIcs

Except for entering your name into the Acme Crime Computer and answer-
ing occasional promotion questions, your keyboard need not be used at all
when playing WHERE IN THE U.S.A. IS CARMEN SANDIEGO? How-
ever, if you enjoy using the keyboard, you may press the Return key
instead of clicking the mouse whenever you see the prompt, “Please click
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here to continue.” In addition, you may type in Y for Yes and N for No
instead of clicking the mouse on the appropriate button. You may also
simply press the Return key to signify a Yes response.

Amiga

Whenever you see the prompt, “Please click here to continue,” you must
click the left mouse button or hit Return. The menu bar is hidden while
playing the game. In order to see the menu options and make a selection,
click the right mouse button to display the menu bar. Drag the mouse
while holding down the right mouse button until the desired menu item is
highlighted, then release the right mouse button.

YOU'RE ON YOUR WAY
Signing in

To get your assignment, you first need to sign in. Type your name into the
Crime Computer and then press Return. Once you've signed in, you'll be
given the details of your assignment. These include the treasure that has
been stolen, whether the thief is male or female, and your deadline for
arresting the criminal. When you’re ready to begin, click the mouse button
and you'll be off on the trail of the thief!

Resuming a Saved Game

If a game has been previously saved under the name you type into the
Crime Computer, you will be asked if you want to resume that game. If
you do, the Crime Computer will refresh your memory on the state of the
game as you leftit. If you don’t resume the saved game, it will be lost when
a new game is begun under the same name. A game in progress will be
automatically saved when you Quit from the File menu.

Briefing

The villain you’re after is hiding out in a city in one of the 50 states or in the
District of Columbia (Washington, D.C.). He or she has left clues along
the way, though. These clues can point to either the city itself or to the
state where the city is located.

Carmen’s gang has 16 members, including Carmen herself. Any one of
them could be the villain, although Carmen is generally more elusive—
and smarter—than the rest of the V.ILL.E. gang.

Clues to the identity of the thief will be given as you pursue the culprit
from city to city. You'll log these clues into the Crime Computer. When
the identity of the suspect has been established, the Computer will issue an
arrest warrant. Obtaining a warrant is very important! If you don’t have
one, you won't be able to arrest the thief once you catch up with him or
her.

During the search you can use the Police Dossiers menu to view the
individual crime file for any of the suspects. Additional information about
the suspects can be found in Carmen’s secret Scrapbook—a stolen copy of
which just happens to have fallen into your hands.

You begin at the bottom of the detective ranks, but as you prove yourself,
promotions will come your way. Before being promoted to each new level,
you must pass a Qualification Quiz using Fodor’s USA travel guide in-
cluded in the package. You will have three chances to answer correctly. If
you pass, you will be immediately promoted. If you fail, you will need to
solve another case before you can retake the quiz. Persevere, catch the
crooks, and you'll climb your way up through the ranks-10 in all-to reach
Super Sleuth status. Even then, you'll add Special Commendations to your
record if you continue to crack the cases.




To track down the villain and solve the case, you'll need your own quick Too I.s or TH E TRADE

thinking and hard-nosed investigative skills, plus the Crime Computer, the

special (included) Map of the United States, Fodor’s USA travel guide, and ) . .
your own purloined copy of Carmen’s secret Scrapbook. You have only a The icons in the lower right corner of the screen help you track down and

limited amount of time to solve each case before the villain gives you the identify t'he villain. The menus across the tOD.Of the screen provide useful
slip. Watch the clock and note the deadline indicated by the Crime Com- information about both gang members and crimefighters.

puter at the beginning of each game.
The icons

Hot on the Trail

Clicking this icon will show a list of all the possible destina-
. .. . . . Show tions reached by connecting flights from your present
Your starting point is the city where the villain (who has just swiped a . , Y con gHg rom your p
valuable state treasure) was last seen. location. It's a good idea to check this first to see where the
thief might have gone. Clicking the mouse on the icon a
second time will remove the list from the screen.
Note: If you double-click one of the listed destinations you will immedi-
ately travel to that location. This provides a shortcut alternative to
clicking the Depart icon described below.

Refer to your official Map of the United States to check locations by city
and state so you'll know where you are and where you're going.

The upper-left portion of the screen always gives you your present location,
the day of the week, and the time.

Be sure to read the descriptions of the city and state that appear on the . . .
screen. These contain valuable information that may be useful in solving Clicking this icon lets you unearth clues so you can track the

later cases. Hint: Take the time to jot some of this information down. suspe.ct. to the next de'stinatioq. A window Wﬂ Ibe djsplayed
You'll be glad that you did! containing three specific locations for you to investigate.

Simply click the one that you want.

Visit as many or as few locations as you wish, but remember that the more
investigating you do, the more valuable time you lose. Use Fodor’s USA
travel guide to help unravel the clues you turn up.
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Clicking this icon lets you depart for the city of your choice
Depart|} once you're ready to take off after the suspect. A map will be
‘ﬂtﬂ' displayed on the screen with a blinking dot at your current
location. Simply click the city to which you want to travel.
Remember, though, that travel takes up lots of valuable time,
so don’t wander from state to state unnecessarily.

When you think you have enough clues to identify the crimi-

INTERF L

- The Crime Computer lists various identifying characteristics
on its screen. Click each characteristic repeatedly to cycle
through the available choices.

When the characteristics you want are displayed, click Compute and the
Crime Computer will search through all known facts about each possible
suspect. A warrant will not be issued if the characteristics fit more than
one suspect; instead, the names of all possible suspects will be displayed.
You’ll have to gather more clues before a warrant will be issued.

Remember, you must have an arrest warrant to nab the thief once
“you catch up with him or her.

To return to the search, click the crime computer.

The Menus

The Police Dossiers menu contains a crime file on each member of
Carmen Sandiego’s gang. The files contain identifying characteristics of
each gang member.

TS
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nal, click this icon and the Crime Computer will be displayed.

The Game menu contains the Hall of Fame which lists all the crime-
fighters who have managed to attain Acme’s top detective rank of Super
Sleuth by capturing Carmen Sandiego herself. This menu also contains the
Acme Detective Roster which provides a list of all crimefighters, their
current rank, and number of cases solved.

The File menu allows you to begin a new game by selecting New Game.
Your old game will be lost when you do this. Selecting Quit from the File
menu lets you leave the program. The current game, if a game is in
progress, will be saved automatically when you select Quit.

The Edit menu is not used in the Macintosh and Apple IIGS versions of
WHERE IN THE U.S.A. IS CARMEN SANDIEGO? It is provided only so
that you can use it with Desk Accessories.

Investigative Pointers

You know you're on the right track when you see a suspicious person or
occurrence on your screen. That’s because the real villain stays in hiding
and has a crony check you out.

The closer you get to the villain the more dangerous your situation be-
comes. Beware of deadly missiles—they mean you’re closing in on your
suspect and things are getting hot!

Don’t waste time using the Crime Computer too often or investigating for
too long at each location. Use Carmen’s secret Scrapbook to pin down the
villain’s identity and your Fodor’s USA travel guide to reveal the villain’s
route—if you use your head you’ll advance faster than fellow detectives
who do nothing but play their hunches.
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Be sure you have an arrest warrant by the time you catch up with the
villain. If you don’t have a warrant, you can’t make an arrest and the thief
will slip through your fingers. And make sure your warrant is for the
correct suspect—otherwise you could be in hot water with the Chief for
risking a charge of false arrest!

Every case you're assigned is different. When you begin a new assign-
ment, you’ll start at a new city, look for a new stolen treasure, and follow a
new suspect over a new route with new clues.

As you advance through the ranks, you’ll get assigned to tougher cases,
with difficult clues to unravel and a longer trail to follow.

If you reach the top of the ranks and have earned all the Special Commen-
dations you can before mandatory retirement, you can always get back in
action by using an assumed name when you sign in. This is a smart move.
After all, your real name may be on Carmen’s hit list!

Carmen’s Scrapbook - Ycur Own Stolen Treasure

Lucky for you, the Acme Detective Agency has managed to purloin
Carmen’s own secret Scrapbook. In it, Carmen has collected mementos
and information about every member of her gang. You can use this
information to identify the V.I.L.E. villain you’re looking for in your current
case. For example, if Carmen notes that one of her henchman’s (or
henchwoman’s) favorite snacks is tacos, you’ll know that the villain’s food
preference is Tex/Mex (a category in the Crime Computer). Clues about
Carmen are found in the Scrapbook, too. But like Carmen herself, these
clues are elusive. You’'ll have to use all your detecting skills as you sift
through the Scrapbook trying to identify this arch-villain’s interests,
hobbies, etc.

Travels with Fodor’s—The Smart Way to Catch a Thief

Your most important investigative tool is your Fodor’s USA travel guide.
Here you'll find information about all 50 states and the District of Columbia
that will help you stay hot on the villain’s trail.

Here’s how to use your Fodor’s USA guide: Let’s say you investigate and
get information that the suspect wanted to visit Cape Canaveral. To figure
out where the clue is leading, you would take the following steps:

1. Use Show Connections and your special Map of the United States to
figure out in which states your current connecting cities are located. Your
connections might include Miami, Annapolis, Helena, and Wilmington. By
looking at the map, you'll find that Miami is in Florida, Annapolis is in
Maryland, Helena is in Montana, and Wilmington is in Delaware.

2. Now look in Fodor’s for information on these states. The first place to
look is the Index at the back of the book. The Index is organized in
alphabetical order. Sometimes you’ll find the information you're looking
for in the Index and you won’t have to look any further.

In this case, when you read through the items listed under Florida, you’ll
find a listing for “Cape Canaveral” under the major heading “Geographi-
cal.” (You'll also find it listed under the major heading “Practical Informa-
tion,” under the sub-heading “Tours.”) Now you know that the villain has
headed for Florida, so grab your suntan lotion and hop the next flight for
Miami.

Some clues are harder to figure out and you’ll need to scan the section for
the state itself. To do this:

A. Turn to the section of Fodor’s devoted to the state you want to check
out. You can find the correct page by looking up the state in the Index or




in the Table of Contents (the Table of Contents is at the front of the book
and is organized by geographic regions).

B. When you’ve turned to the section for the state, take a look at the state
map (included in each section). You’ll find the answers to some clues right
on the map.

C. If you don’t find the answer on the map, scan the section headings
(printed in darker type). You'll find the answers to some clues contained in
these headings. For example, in the section on Illinois, one of the headings
is “Land of Lincoln.” If one of the clues you've been given is that the thief
is doing research on Lincoln, then it’s a good bet that he or she is heading
for Illinois.

D. Sometimes you'll have to dig further. You'll notice that the sections for
each state list such things as Museums, Historic Sites, Entertainment, and
Sports. Check these sections for answers. For example, you may have
learned that the villain plans to visit an infamous Confederate prison, and
one of the possible connections is in Georgia. If you look in the section on
Georgia, under the category Historic Sites, you’ll find that prison—Ander-
sonville. ~

E. Some clues are buried even deeper. You may have to read through the
text for each state or check the general articles—The Arts in America,
Distinctive American Vacations, etc.—at the beginning of the book. Also,
remember to read the state descriptions—and note the pictures—that
appear on the screen. Some clues are contained in these.

A Final Hint

Don’t hesitate to use other reference books you may have on hand. The
biographical and geographical sections of a dictionary may be helpful, as
well as an encyclopedia, a map, or an Almanac. Use whatever you can to
help you unravel the clues, save time, catch the crooks, and earn those
promotions!

PLEASE DO NOT MAKE ILLEGAL COPIES OF THIS SOFTWARE

The software you are using was produced through the efforts of many
people: designers, art programmers, distributors, retailers and
other dedicated workers.

The costs of developing this and other software programs are recov-
ered through software sales, The unauthorized duplication of personal
computer software raises the cost to all legitimate users.

This software is protected by federal copyright law. Copying software
for any reason other than to make a backup is a violation of law. Indi-

viduals who make unauthorized copies of software may be subject to
civil and criminal penalties.

Broderbund Software, Inc.

as a member of the Software Publishers Association (SPA) supports the
industry's effort to fight the illegal copying of personal computer
software.

Report copyright violation to:
SPA, 1101 connecticut Avenue, NW, Suite 901
Washington, D.C. 20036




Broderbund’s Limited Ninety-Day Warranty

Brederbund warrants for a period of ninety (90) days following the original retail purchase of this copy of Where in the
U.S.A. is Carmen Sandiego? that the program is free from substantial errors or defects that will materially interfere with
the operation of the program as described in the enclosed user documentation. This policy applies to the initial
purchaser only.

If you believe you have found any such error or defect in the program during the warranty period, call Brederbund’s
Technical Support Department at 415/382-4700 between the hours of 8 a.m. and 5 p.m. (Pacific Time), Monday through
Friday. Brederbund technical personnel will attempt to help you correct or avoid the problem. If any such error or defect
cannot be corrected or reasonably avoided, Braderbund will inform you how to obtain a corrected program disk (or, at
Braderbund’s option, Brederbund may authorize a refund of your purchase price).

This warranty gives you specific legal rights, and you may also have rights which vary from state to state.

Disk Replacement Policy

If any disk supplied with this product fails within ninety (90) days of purchase for any reason other than accident or
misuse, please return the defective disk together with a dated proof of purchase to Braderbund Software-Direct®, P.O.
Box 6125, Novato, CA 94948-6125, for a free replacement. This policy applies to the original purchaser only.

Braderbund will replace program disks damaged for any reason, whether during or after the ninety (90) day free
replacement period, for $5 per disk plus a postage and handling charge of $2.50 per request. For programs that
originally include 3 or more program disks, send just $15.00 and $2.50 postage and handling per request. This policy will
be followed as long as the program is still being manufactured by Braderbund.

Limitations on Warranty

Unauthorized representations: Brederbund warrants only that the program will perform as described in the user
documentation. No other advertising, description or representation, whether made by a Brederbund dealer, distributor,
agent or employee, shall be binding upon Brederbund or shall change the terms of this warranty.

IMPLIED WARRANTIES LIMITED: EXCEPT AS STATED ABOVE, BRODERBUND MAKES NO OTHER WARRANTY,
EXPRESS OR IMPLIED, REGARDING THIS PRODUCT. BRODERBUND DISCLAIMS ANY WARRANTY THAT THE
SOFTWARE IS FIT FOR A PARTICULAR PURPOSE, AND ANY IMPLIED WARRANTY OF MERCHANTABILITY
SHALL BE LIMITED TO THE NINETY (90) DAY DURATION OF THIS LIMITED EXPRESS WARRANTY AND IS
OTHERWISE EXPRESSLY AND SPECIFICALLY DISCLAIMED. SOME STATES DO NOT ALLOW LIMITATIONS ON
HOW LONG AN IMPLIED WARRANTY LASTS, SO THE ABOVE LIMITATION MAY NOT APPLY TO YOU.

NO CONSEQUENTIAL DAMAGES: BRODERBUND SHALL NOT BE LIABLE FOR SPECIAL, INCIDENTAL,
CONSEQUENTIAL OR OTHER DAMAGES, EVEN IF BRGDERBUND IS ADVISED OF OR AWARE OF THE
POSSIBILITY OF SUCH DAMAGES. THIS MEANS THAT BRODERBUND SHALL NOT BE RESPONSIBLE OR LIABLE
FOR LOST PROFITS OR REVENUES, OR FOR DAMAGES OR COSTS INCURRED AS A RESULT OF LOSS OF
TIME, DATA OR USE OF THE SOFTWARE, OR FROM ANY OTHER CAUSE EXCEPT THE ACTUAL COST OF THE
PRODUCT. IN NO EVENT SHALL BRGDERBUND'S LIABILITY EXCEED THE PURCHASE PRICE OF THIS
PRODUCT. SOME STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTAL OR
CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU.

You are entitled to use this product for your own use, but may not sell or transfer reproductions of the software or manual
to other parties in any way, nor rent or lease the product to others without the prior written permission of Brederbund.
You may use one copy of the product on a single terminal connected to a single computer. You may not network the
product or otherwise use it on more than one computer or computer terminal at the same time.

For technical support, on this or any other Brederbund product, call 415/382-4700. © Copyright 1986,1990 Brederbund
Software. Inc., 500 Redwood Bivd., Novato, California 94948-6121. All rights reserved.
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